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1 Getting Started

1.1 What does SpaceMan 99 do?

SpaceMan 99 is an application that can help you find out which files and folders are using up most of

your disk space. It also contains facilities to help find files that can be deleted to make more space

available. It performs two main functions.

Finding disk space used by folders

SpaceMan 99 can show the total amount of disk space used by all the files within each folder. This can

be used to find out which folders are using the most disk space.

Finding duplicate files

SpaceMan 99 can also find duplicate files and folders. This can be useful both for freeing up disk space

by deleting unnecessary copies, and for helping sort out files on a disorganized disk.

One of SpaceMan 99's unique features is the Mark Duplicate Files panel. This provides powerful

commands to automatically select duplicate files for deletion.

1.2 System Requirements

SpaceMan 99 runs on the following versions of Windows:

Windows 8

Windows 7

Windows Vista

Windows XP

1.3 Quick tour of SpaceMan 99

SpaceMan 99 works in a similar way to the Windows Explorer application, except that it has two extra

panels at the bottom that are used for showing duplicate files.

The following screen shot shows SpaceMan 99 after a duplicates scan has been run. The various parts of

the application window are indicated.
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Toolbar This provides quick access to the most commonly used menu commands.

Current Folder This shows the currently selected folder. New paths can be entered in this box,

or the last 20 quickly accessed from the drop-down list.

Folder Browser This shows a hierarchical view of all the folders on the system. To scan a

folder, click the checkbox next to the name.  Each folder can be expanded or

collapsed by clicking on the + or - symbol next to the folder name. When a

folder and all its subfolders have been scanned for disk space, the disk space

is shown to the left of the folder’s name in square brackets. The contents of the

folder selected in the Folder Browser are shown in the File Browser.

File Browser This shows the folders and files in the currently selected folder. When a file has

been scanned to test for duplicates, a symbol will appear to the left of its

name, to show whether it is a duplicate or not. When all the files in a folder

have been scanned to test for duplicates, a symbol will appear next to that

folder’s name to show whether that folder is an exact duplicate of another

folder.
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Find Duplicates

Options

These controls set whether duplicate files are scanned for, and if so, the criteria

that must be met for two files to be considered to be duplicates.

Duplicates List When duplicate files are found, a line is added to this list which shows the

names of the files that are duplicates of each other, and the size of the files.

Duplicate Files This shows the individual files in the duplicates set selected in the Duplicates

list. All the files shown in this list are duplicates of each other.

Resizing the panels

The sizes of each of these panels can be changed by moving the bars that run between them. There is a

single bar running horizontally that separates the folder and file browsers from the duplicates list and the

duplicate files browsers. This can be dragged up or down. There are two vertical bars that can be dragged

independently. One separates the folder browser from the file browser, and the other separates the

duplicates list browser from the duplicate files browser.

1.4 The folder browser

The Folder Browser is used to:

Browse through all the folders on the system.

Show the total disk space used by all files in a folder.

Select a folder for scanning.

Select a folder for viewing in the File Browser.

Select a folder for use by the Mark Duplicate Files panel.
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Move or copy files and folders using drag and drop.

Scanning a folder

To scan a folder, click the checkbox next to the folder name with the left mouse button.

When a folder is selected for scanning, its children are also automatically selected.  To exclude a

subfolder, click the checkbox again so that it shows a cross.

The checkboxes will show one of these states:

The folder has been selected for scanning.

The folder has been excluded from scanning.  This state can only be set for a folder that would

have been scanned due to its parent being selected for scanning.

The folder is selected for scanning due to a parent being selected.

The folder is not selected for scanning, and it does not contain any subfolders that are selected

for scanning.

The folder is not selected for scanning, but contains one or more subfolders that have been

selected to be scanned.

When a folder is selected for scanning, it’s name in the browser will be preceded by empty square

brackets `[ ]`. Once it has been scanned, including all subfolders under it, the total amount of disk space

used by all files under the folder will be shown in the square brackets.

If scanning for duplicates is also enabled, then any duplicate files found in the folders that are scanned

will be shown in the Duplicates List Browser.

The currently selected folder is shown in the File Browser.

Right clicking on a folder brings up the folder context menu.

To expand a folder to show subfolders:

Click on the + icon next to the folder name, or

Double click on the folder name.

To contract a folder to hide its contents:

Click on the - icon next to the folder name, or

Double click on the folder name.
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Links

If a folder appears to be missing from the folder browser, since could be because it is a link.  SpaceMan

99 does not follow links since these can cause problems such as "ghost" duplicates or infinitly deep

folder hierarchies.

1.5 The file browser

The file browser shows the contents of the folder currently selected in the Folder Browser.

For each item in the folder, the following information can be listed:

Name

Disk space used

File size, or total size of all contained files for folders

Modification time

Total number of files contained in a folder and all subfolders (this will always be blank for files)

Total number of subfolders contained in a folder (this will always be blank for files)

The number of duplicates

The Name column is always shown. The other columns can be shown or hidden depending on the

options set in the column options panel. A quick way to set these options is to right click on any of the

column headers, and select the columns from the menu that pops up.

All these columns except name and modification time will only be shown for folders if the folder has been

scanned.
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The Number of duplicates column only has values if the file has been scanned for duplicates. The value

shown includes this file, so if no other copies of the file have been found, the value shown is 1. If the file

has one other copy, the value shown is 2, and so on.  For folders, this shows the number of folders that

are duplicates of the folder.

The file list can be sorted by any column. By default it is sorted by file size. To change this, click in the

title box of the column you want to sort by. If you click a second time in the same title box, the sort

order is reversed.

Note: Sorting by the number of duplicates provides a quick way of bringing all the files that have

duplicates together.

Once a folder has been scanned for duplicates, the file browser also shows whether each file is unique,

or if there is another copy of the file. This is shown by one of the following symbols next to the name:

File or folder is unique

There is another copy of this file or folder

Empty file or folder

Folder contains one or more unreadable files or folders.

Unreadable file or folder, probably due to no read access.

A folder is shown as empty if it contains no files. An empty folder may contain subfolders, but none of

these subfolders can contain any files either. Empty folders can be quickly deleted using the delete

empty folders command.

For two folders to be shown as duplicates of each other, they must contain exactly the same files

(including the same filenames). If they contain any subfolders, these must be identical as well. If a folder

is marked as being a duplicate, then the other folder(s) that it is a duplicate of can be seen by using the 

Next Duplicate and Previous Duplicate commands. These commands are only enabled if a duplicate

folder is selected, and they cycle the selected folder between folders that are duplicates of each other.

When a file is shown to be a duplicate, the other copies of that file can be found by selecting the file. The

other copies of the file will then be shown in the Duplicate Files Browser.

Right clicking on a folder brings up the folder context menu, and right clicking on a file brings up the file

context menu. Multiple folders or files can be selected by holding down SHIFT while selecting to extend

the selection, or CTRL to toggle the selection status of the item picked.
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1.6 The duplicates list browser

The duplicates list browser shows the duplicate files that have been found. This window is only enabled if

the Find Duplicate Files checkbox is checked. Each line in the list shows one set of files that are all

duplicates of each other. The information that can be shown for each set of duplicate files is:

File names. If two or more files have the same name, the name is only shown once.

File size. All files must be the same size since they are duplicates of each other.

The number of duplicate files.

The total size of the duplicate files.

The Name column is always shown. The other columns can be shown or hidden depending on the

options set in the column options panel. A quick way to set these options is to right click on any of the

column headers, and select the columns from the menu that pops up.

To see the full paths to each of the files in a duplicates set, select the line. The Duplicate Files Browser

will then show the path for each file.

Right clicking on a duplicates set brings up the file context menu. Selecting one of the commands in this

menu will cause the command to be applied to each of the files in the duplicates set.

The duplicates list can be sorted by name, size, number of duplicates or total size of duplicates. By

default, it is sorted by size. To change this, click in the title box of the column you want to sort by. If you

click a second time in the same title box, the sort order is reversed.

During scanning, duplicates are added to the duplicates list as they are found. The list is kept sorted

until more than 1,000 duplicates have been found. From then on, new duplicates are added to the end of

the list. If you want to resort the duplicates while scanning is still in progress, simply click in the title box

of the column you want to sort on. When scanning completes, the list will be resorted automatically. The

reason for not keeping the duplicates list sorted once more than 1,000 duplicates have been added is

that it would make the duplicates scanning process much slower if a large number of duplicates are
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found.

When the keyboard focus is in this window, you can use F11 to advance to the next duplicates set, and

SHIFT+F11 to go back to the previous one.

1.7 The duplicate files browser

The Duplicate Files Browser shows each of the files that are in the currently selected duplicates set in

the Duplicates List Browser. The files shown in the Duplicate Files Browser will be duplicates of each

other.

For each file in the list, the following information can be listed:

Name

Full path to the file.

Modification time

The Name column is always shown. The other columns can be shown or hidden depending on the

options set in the column options panel. A quick way to set these options is to right click on any of the

column headers, and select the columns from the menu that pops up.

Selecting a file in the Duplicate Files Browser causes the Folder Browser to be expanded to show the

folder in which the file exists. The file is also selected in the File Browser.

Right clicking on a file brings up the file context menu.

 Pressing F5 in this window advances to the next duplicates set, and shift+F5 steps back to the

previous duplicates set. This allows you to go through all the duplicate files marking the ones you

choose, using just keyboard shortcuts.
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1.8 Current folder box

The Current Folder box shows the path to the folder that is selected in the folder browser, which is the

folder listed in the file browser.

Each time the current folder is changed, this box is updated to show the new folder path.

A new folder path can be typed or pasted into this box, and this will be selected as the new current folder

when return is pressed.

The last 20 folder paths are stored. These can be accessed by pressing the drop down button to the right

of the box. By default, this list is saved to the registry when SpaceMan 99 is closed, and read back

when SpaceMan 99 starts. If you do not want this recent folders list to be saved between SpaceMan 99

sessions, go to the options panel and check the Clear recent folders list when app exits checkbox.

The size and position of the address box can be adjusted by dragging the left edge.

If you find that when you enter a path into the current folder box, a different folder is selected in the folder

browser, then this is because one or more folders in the path you entered must be a link.

2 How To

2.1 Finding disk space used by folders

To find the total disk space used by all the files in a folder, and in all subfolders under it, click the

checkboxes next to the folders in the Folder Browser with the left mouse button. The folders and all their

subfolders will then be scanned for size.

The total disk space used by all files in a folder (and all subfolders) is shown in square brackets next to

the folder name. If the square brackets next to a folder name are empty, it means the size for that folder

is still being calculated.

 If the Find Duplicate Files checkbox is checked, folders are also scanned for duplicate files. If you

only want to find folder sizes, it will be much quicker if you uncheck this box before scanning any folders.

2.2 Finding duplicate files

To find duplicate files, first make sure that the Find Duplicate Files checkbox is checked.

Then click the checkboxes next to the folders you want to scan in the Folder Browser with the left

mouse button. The checked folders and all their subfolders will then be scanned.

All duplicates found will be listed in the Duplicates List Browser.
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Note that duplicate files can only be found if all the folders containing the copies of a file are scanned.

For example, if there is a file in C:\Folder1 that has a duplicate in C:\Folder2, then if only C:\Folder1 is

scanned, the file will be shown as unique. Only when C:\Folder2 is scanned as well will the duplication

be found.

Problems that can occur when scanning for duplicates

You may find that sometimes when you select a folder for scanning, some files within it do not get

scanned. This can be due to one of the following reasons:

The file is already open in another application. Close all other applications and try again.

You do not have read access for the file. Check the permissions and ownership of the file.

2.3 Deleting files

Any file or folder can be deleted by simply selecting it, and choosing the delete command.

You should always take great care when deleting files, as you can lose work or stop something from

working if you delete the wrong file. The best rule is, if you don’t know what a file is, then don’t delete it.

By default, SpaceMan 99 protects most files used by the Windows operating system. To turn this

protection off, use the options panel.

Deleting duplicate files

SpaceMan 99 has special purpose commands built in to help find and delete duplicate files. First, you

can mark duplicate files. The files marked can then be reviewed by viewing the marked files as a list, or

by browsing through folders and seeing the marked files in the file browser. Once you are sure you have

marked exactly the files you want to delete, you can use the delete marked files command. This

provides a safe way to delete files and be sure you still have at least one other copy of any file deleted.

Note, however, that just because a file is a duplicate, this does not always mean it can be safely

deleted. For example, an application may install a copy of a file that already exists on the system, but if

the application only looks for the file in the new location, it will fail if the new copy of the file is deleted.

3 Reference

3.1 File menu

The File menu offers the following commands:

Open Opens the selected file(s).
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Explore Opens the selected folder in Windows Explorer.

Delete Deletes the selected file(s) or folder(s).

Delete Empty Folders Deletes any empty folders under the selected folder.

Clear All Data Clears all folder size and duplicate file data.

Next Duplicate Selects the next duplicate of the currently selected file or folder.

Previous Duplicate Selects the previous duplicate of the currently selected file or folder.

Report Brings up the Reports panel.

Exit Exits SpaceMan 99.

3.2 Mark menu

The Mark menu offers the following commands:

Mark Mark the currently selected file(s).

Unmark Unmarks the currently selected file(s).

Mark Duplicate Files Marks duplicate files in the currently selected folder.

Unmark All Files Unmarks all files.

View Marked Files Brings up a panel that shows all marked files.

Delete Marked Files Deletes all marked files.

3.3 Filter menu

The Filter menu offers the following commands:

Filter Files Brings up the File Filter panel

Clear Filters Clears any file filters that have been set.
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3.4 View menu

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.

Status Bar Shows or hides the status bar.

Show Size As Popup menu that allows the units used to show sizes to be customized.

Refresh All Refreshes all the views shown.  Also re-reads the current folder, and updates all

the views if there have been any changes.

Options Brings up the Options panel

3.5 Help menu

The Help menu offers the following commands, which provide you assistance with this application:

Help Topics Offers you an index to topics on which you can get help.

Check For Updates Opens a web page that shows whether you have the latest version of

SpaceMan 99.  If there is a newer version, a link to download the

latest version will be provided.

About SpaceMan 99 Displays the version number of this application, and whether it is in

trial mode or not.

3.6 Toolbar

The toolbar is displayed across the top of the application window, below the menu bar. The toolbar

provides quick mouse access to many tools used in SpaceMan 99.

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Pauses the scan, if scanning is active.  Press again to resume scanning.
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Clears all scanned data.

Brings up the Report panel.

Brings up the File Filter panel. This button is shown grayed if no file filter is set.

Bring up the About box.

Bring up the context sensitive help cursor.

The position of the toolbar can be adjusted by dragging the edge to the left of the buttons.

3.7 Find Duplicates Controls

The Find Duplicate Files controls are above the Duplicates List Browser.

When the Find Duplicate Files box is checked, SpaceMan 99 will scan for both duplicate files/folders

and folder size when  folders are scanned. Any duplicate files found will be shown in the Duplicates List

Browser.

If the box is not checked, then SpaceMan 99 will only scan for folder size. If you only want to scan

folders for size, it is much quicker to turn off the Find Duplicate Files option.

Shortcut

Key: F2

See Also

Omit Small Files

Match Contents

Match Filename

Match Date
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3.8 Mark Duplicates panel

 To bring up the mark duplicate files panel, select a folder in the folder browser, and then use the mark

duplicate files command.

When the mark duplicate files panel appears, the selected folder is shown at the top of the panel. To

change the selected folder, close down the panel, select a new folder, and then use the mark duplicate

files command again. You can not simply type a new selected folder path into the panel itself.

The mark duplicate files panel provides a way to mark duplicate files so that all copies of a file can not be

marked. This makes it easy to delete redundant copies of a file without accidentally deleting all copies of

a file. There are a number of options to allow you to set which of the duplicate files is not marked.

Mark duplicate files inside selected folder except newest

This option marks all duplicate files inside the selected folder (or any subfolder), except the file in each

set of duplicate files that has the newest modification time. If more than one of the duplicate files have

the newest modification time, then it will be arbitrary which of them is not marked.

Mark duplicate files inside selected folder except oldest

This option marks all duplicate files inside the selected folder (or any subfolder), except the file in each

set of duplicate files that has the oldest modification time.

Mark duplicate files inside selected folder, which have a copy outside

This option marks all duplicate files inside the selected folder (or any subfolder), provided they have at
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least one copy outside the selected folder. This is useful if you want to delete a folder and be sure that

you still have copies of all the files it contains elsewhere on the system.

Mark duplicate files outside selected folder, which have a copy inside

This option marks all duplicate files outside the selected folder, provided they have at least one copy

inside the selected folder (or any subfolder). This option allows you to clean up your system so that any

copies of a file are in a known folder. If you have some files that you may have several copies of in

different places, you can choose one folder where you want these files to be stored. After putting one

copy of these files in the chosen folder, you can use the mark duplicate files command to mark any

other copies of these files anywhere else on your system (or at least, in any other folders you have

scanned).

When the mark duplicate files command is selected, the first thing that happens is that all files in the

selected folder are checked to see if any are duplicates. If the selected folder has not been scanned for

duplicates and nor have any subfolders under it, or if no duplicate files are found, then a message box is

shown. Otherwise the mark duplicate files panel appears. If the list of files shown in the mark duplicate

files panel is empty, then all the duplicate files found in the selected folder only have copies that are also

inside the selected folder.

The list inside the panel shows the files that will be marked if the Mark button is pressed. The list

changes as you select between the different options for selecting which duplicates are marked.

Note that when the mark duplicate files panel is brought up, it does not perform any new scanning of

files. You should make sure that all folders that you want to check for duplicates have already been

scanned before bringing up the mark duplicate files panel. For more information on scanning for duplicate

files follow this link.

3.9 File Delete Option

When you first delete a file in SpaceMan 99, the following dialog will appear:
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The top radio control is used to select how you want to delete the file(s).

Use the Windows Recycler.  This has the advantage that the deleted files will go into the recycle bin,

which allows the files to be restored if you change your mind about deleting them (as long as the

Recycler settings aren't set to delete files immediately).

Delete permanently.  This has the advantage that it can be much faster, especially if a lot of files are

being deleted.  However, files deleted in this way cannot be restored.

The bottom radio control is used to set whether you want to make this selection every time.

Ask each time.  This panel will appear each time a command is used that deletes any files.

Use this setting until the application is closed.  This panel will not appear again during this session

of SpaceMan 99, and the selected delete option will be used each time.  However, after is has been

quit, then this panel will appear again the next time it is run.

Use this setting and don't ask again.  This panel will not appear again, and this will also be

remembered next time SpaceMan 99 is run.  The selected delete option will be used automatically

from now on.

If you choose an option to not have this panel appear again, you can still change how files are deleted

(and whether this panel is shown) in the General Options panel.

3.10 Marked Files panel

 To bring up the marked files panel, use the view marked files command.

This panel shows all the files that are currently marked. Files in the list can be unmarked (which removes

them from the list) or deleted by using commands on the marked files menu.

Marked files can be sorted by name, size or path. Click on the appropriate column header to sort on that

value. Clicking a second time on the same column header reverses the sort order.

To change the sizes of the columns, drag the right edge of the column headers.

Right click on a file in the list to bring up the context sensitive menu that lets you perform the following

actions:

Unmark Unmarks the selected file(s), which removes them from the list of

marked files.

Copy Path to Clipboard Copies the full path to the select file(s) to the clipboard.
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Copy All Paths to Clipboard Copies the full paths of all marked files to the clipboard, one per

line.  This is the only command on this menu that does not just

apply to the select file(s).

Delete Deletes the selected file(s).

3.11 Report panel

 To bring up the report panel, use the report command.

Before you use the report panel, you need to have scanned one or more folders for disk space, or for

duplicate files. To select the report you want to see, click on one of the tabs at the top of the report

panel. The report panel can show each of the following reports.

Total Folder Sizes report

This report shows the total size of all files in each scanned folder, including subfolders. It also shows the

total size of all the subfolders under each folder. The folders are sorted first by depth (i.e. how deep in the

folder hierarchy they are), and then by size, with the largest shown first. The size shown is either the

total disk space used by the files, or the sum of the individual file sizes, depending on the option set on

the Report Options panel.

Folder Sizes report

This report shows the total size of all files in each scanned folder, excluding subfolders. The folders are

sorted by size, with the largest shown first. The size shown is either the total disk space used by the

files, or the sum of the individual file sizes, depending on the option set on the Report Options panel.

Duplicate Files report

This report shows all the duplicate files. The first column shows the file sizes. If the option to show the

last-modified time is selected in the Report Options panel, then the second column shows the last-

modified time for each file. The last column shows the duplicate files.

The files are grouped so that files that are duplicates of each other are shown together. Each set of

duplicate files is separated by a blank line. Since the size of all files that are duplicates of each other

must obviously be the same, the size is only shown once per duplicates set.

Duplicate Folders report

This report shows all the duplicate folders. The first column shows the total size. This is shown either as

the total disk space used by the files, or the sum of the individual file sizes, depending on the option set

on the Report Options panel. The second column shows the path to the folder.

The folders are grouped so that folders that are duplicates of each other are shown together. Each set of

duplicate folders is separated by a blank line.
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The following buttons are at the bottom of the report panel:

Options This brings up the Options panel with the Report tab selected. This allows

you to make changes to the report options while the Report Panel is

displayed.

Copy To Clipboard Copies the current selection from the current report to the clipboard. A

selection can be made in the current report by dragging over the part you

want to select. If there is no selection, then the whole report is copied to the

clipboard. This can then be copied into another application. When a report is

copied to the clipboard, the columns in the reports are separated by the TAB

character. This means that the data can be copied into a spreadsheet such

as Excel, and the data will be copied properly into rows and columns. It is

then easy to make charts of the data if you want to see the results

graphically.

Print Prints the current selection from the current report, or the entire report if

there is no selection.

OK Closes the report panel.

3.12 File Filter panel

 To bring up the File Filter panel, use the Filter Files command.

The file filter panel allows files to be excluded when the disk is being scanned. This can be used either to

simply speed up the scanning operation by excluding files that you are not interested in, or to gather



SpaceMan 9922

© 2015 ExtraBit Software

information about specific files, such as how much disk space is being used by a particular type of file.

The files that are filtered out can be specified in one of two ways. You can either list the files that should

be excluded, or list just those that should be included. To select which of these to use, click on the pop-

up list box and select the required option.

To specify the files to exclude or include, the standard wild-card symbols * and ? are used. * matches

any characters, and ? matches any one character. By far the most common way to specify files to

exclude or include is by the file extension, since this defines the type of the file. For example, to specify

all Microsoft Word files, you would use *.doc.

The wild-card symbols can be used in any combination, so fairly powerful patterns can be defined. For

example, a*.??? would match any filename that started with a, and had an extension that had exactly

three characters.

To add a file to the list, press the New Filter button. This adds an entry to the list which you can then

type into.

To change a filter, double click it in the file list box and make the change required.

To remove a filter, select it in the file list box and press the Remove Selected Filter button.

To remove all filters, press the Remove All Filters button.

Note that excluded files are no longer shown in the file browser. They will reappear in the file browser if

the filtered files list is cleared.

Predefined file groups

Various predefined file groups can be quickly added by selecting them from the predefined file groups

pop-up list. This has file patterns for various common groups of files, such as common image file types,

temporary files, and so on.

This list can be customized by editing the file filegroups.txt in SpaceMan 99’s installation folder. This file

starts with the name of the first group on one line, followed by lines containing the file patterns making up

that group, and ending in a blank line. The next group then follows, and so on until the end of the file.
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3.13 General Options panel

 To bring up the General options panel, use the view options command, and select the General tab.

The General tab of the Options panel allows you to set the following options:

File Protection Sets whether the Windows operating system files are protected from deletion. If

this option is enabled, then you will be unable to delete any files in the Windows

folder from within SpaceMan 99.

The protected folder is shown. This is fixed by the operating system and can not

be changed.

Sounds Sets whether SpaceMan 99 plays a sound whenever a scan is finished.

Recent Folders The Address Box stores the 20 most recently accessed folders. This list is

saved between SpaceMan 99 sessions unless the Clear recent folders list when

app exits checkbox is set.

File Delete Options Sets whether to use the Windows Recycler when deleting files.  If Use

Windows Recycler is checked, then files will be deleted using the Windows

Recycler.  Otherwise, files will be permanently deleted.

If the Ask Before Deleting option is checked, then the File Delete Option panel

will appear each time you use a command that deletes any files.
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3.14 Column Options panel

 To bring up the Column options panel, use the view options command, and select the Columns tab.

The Columns tab of the Options panel allows the columns shown in each of the files browser, duplicates

list and duplicate files views to be configured.

Using the context menu
Note that it is also possible to configure the columns shown without using the Column Options panel.

Right clicking in the column title boxes brings up a context menu that lists the columns available. The

columns shown have a check mark against them. Selecting one of the columns from the menu toggles

the state of the check mark and shows or hides the column.
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3.15 Report Options panel

 To bring up the Report options panel, use the view options command, and select the Reports tab.

The Reports tab of the Options panel allows the reports generated in the Report panel to be customized.

The Show Size As option selects whether the file or folder sizes shown in the reports are the actual

sizes of the files or folders, or whether they are the amount of disk space used. Click here to find out

why these numbers are usually different.

The Sort Order option selects whether the items in the reports are sorted by size (largest first) or

alphabetically by filename.

If the Show Modified Time in Duplicates Report box is checked, then an extra column will be included in

the duplicates report that shows the modified time for each file.

3.16 Scanning Folders

Before any duplicate files or folder sizes can be shown, one or more folders need to be scanned. When a

folder is scanned, all subfolders within that folder are also scanned.

To scan a folder, check the box next to it in the Folder Browser.

More folders can be selected for scanning before the first has been finished. The path to the folder

currently being scanned is shown in the status bar. When several folders have been selected for

scanning, SpaceMan 99 gives priority to the currently selected folder. Once the currently selected folder

(and all subfolders under it) has been scanned, SpaceMan 99 will scan all the remaining folders that have
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been selected for scanning.

At any time, scanning can be paused by clicking the pause scan button on the toolbar.

When all scanning is finished, SpaceMan 99 will flash briefly, and if the beep when scan complete option

is set, a beep will be sounded.

Finding the folder to scan

To find the folder to scan, you can:

Browse folders in the Folder Browser, or

Type or paste the full path to the folder in the current folder box

If you have the folder open in Windows Explorer, right click on the folder and select the Open in

SpaceMan 99 menu command.  This command is added to the Windows Explorer context menu by

the SpaceMan 99 Windows Explorer shell extension that is installed along with SpaceMan 99.

 If you want to scan a folder on your network, you have to either open it from Windows Explorer, or

enter the path in the current folder box, as described above.  Network paths (i.e. those that start \\server

\path...) are not shown in the folder browser until they have been selected in one of these ways.

Rescanning folders

If any files are changed, added or removed by another application, then if SpaceMan 99 has already

scanned the affected folders, the information gathered by SpaceMan 99 has to be cleared so that the

folder will be scanned again. The easiest way to do this is to use the Clear All Data command. This

clears all information gathered by SpaceMan 99.

3.17 Links

The NTFS file system used by Windows allows folders to contain links that look like folders, but are in

fact just a link to another folder.  These links can be made using symbolic links or junction points.

If SpaceMan 99 simply treated links as folders (which is how they appear to most programs), this could

cause problems since it could appear that the same file was at two different paths.  This would make a

file appear to be a duplicate of itself, but if one of these "duplicates" was deleted then both would be

gone since there was only one file to start with.

Another problem with links is that it is possible for to create a link in a subfolder to one of the parent

folders of that subfolder.  To programs that are not link aware, this will then appear to be an infinitely

deep folder hierarchy, as you would get stuck in the loop when descending the hierarchy.

SpaceMan 99 therefore does not follow links.  Links will appear as folders in the file browser, but do not

appear in the folder browser.

http://en.wikipedia.org/wiki/NTFS_symbolic_link
http://en.wikipedia.org/wiki/NTFS_junction_point
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3.18 Checksum

One of the options in the Match contents drop down list is Checksum & Size

This page explains what a checksum is.

A checksum is simply a number that is calculated from all the bytes in the file. A very simple example of

a checksum would be to add together all the bytes. This is a true checksum in the original sense of the

name, although simply adding the bytes of a file is rarely used to calculate a checksum these days. One

of the deficiencies of this technique is that it's not very good at distinguishing between similar but

different files. For example, two files with the same bytes but in a different order would have the same

checksum.

SpaceMan 99 uses a more sophisticated algorithm called CRC-32.

CRC stands for Cyclic Redundancy Check, and 32 refers to the fact that the checksum calculated has

32 bits. This means that the checksum will be in the range 0 to 4,294,967,295.

Once the checksum has been calculated for two files, if the checksums are different it is guaranteed that

the data in the files is different. However, if the checksums are the same it is not guaranteed that the

files are the same. This is because many different files will have the same checksum. For a 32 bit

checksum, the chances that two files with the same checksum are different is 1 in 4,294,967,296.

3.19 What's the difference between disk space and file size?

The file browser shows two different sizes for files. This is due to the fact that when files are stored on a

disk, the amount of disk space used is usually greater than the size of the file. This is because disks are

divided into clusters and each file takes up a whole number of clusters. The cluster size depends on the

type of file system and the size of the disk. For the most common file systems FAT-32 or NTFS, the

cluster size is between 512 bytes and 4 Kbytes, which means a 1 byte file could still take up as much

space as a 4,096 byte file.

It is also possible to have a file that takes up less disk space than the size of the file. This can happen if

the file is compressed. Disks using the FAT file system can be set to have the entire drive compressed.

Disks using the NTFS file system allow compression to be set on a file by file basis. Note that the

compression and decompression of a file is entirely automatic, so the file will appear no different after it

is compressed. The only reason for not always using compression is that a compressed file may take

slightly longer to access.



SpaceMan 9928

© 2015 ExtraBit Software

4 Ordering

4.1 How to buy

The easiest way to buy SpaceMan 99 is to press the "Buy" button on the panel that appears when the

trial version starts. This opens your web browser to show the SpaceMan 99 buy page:

www.extrabit.com/spaceman99/buy

When you buy SpaceMan, you will receive a serial code that you will need to enter into the registration

panel.

If you have any questions about buying SpaceMan 99, send an email message to support@extrabit.com.

4.2 End user license

END-USER LICENSE AGREEMENT FOR SPACEMAN 99

1. Introduction

This License applies to the SpaceMan 99 software and its accompanying files, data and materials

("SpaceMan 99"). You should carefully read the following terms and conditions before using, installing,

copying, or distributing this software. Unless you have a different license agreement signed by ExtraBit

Software. ("ExtraBit"), your use, installation, copying, or distribution of SpaceMan 99 indicates your

acceptance of this agreement ("License"). The terms and conditions of this License describe the

permitted use and user(s) of the evaluation version of SpaceMan 99, and of each Licensed Copy of

SpaceMan 99. For the purposes of this License, if you have a valid single license, you have the right to

use a single "Licensed Copy" of SpaceMan 99; if you or your organization has a valid multi-license pack,

then you or your organization has the right to use up to a number of "Licensed Copies" of SpaceMan 99

equal to the number of copies indicated in the documents issued by ExtraBit when granting the license;

if you or your organization has a site-license, then you or your organization has the right to use unlimited

"Licensed Copies" of SpaceMan 99 on computers owned by the licensee or employees of the licensee

provided they are all used at a single site (a site being defined as one or more buildings within a 10 mile

radius); if you or your organisation has a worldwide-license, then you or your organization has the right to

use unlimited "Licensed Copies" of SpaceMan 99 on computers owned by the licensee or employees of

the licensee.

2. Scope of License

2.1. Evaluation

This is not free software. Subject to the terms below, you are hereby licensed by ExtraBit to use one

copy of SpaceMan 99, on one (1) computer or workstation, for evaluation purposes without charge for a

http://www.extrabit.com/spaceman99/buy
mailto:support@extrabit.com
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period of 30 days. If you use this software after the 30-day evaluation period, a license fee is required.

Use of SpaceMan 99 after the 30-day evaluation period without payment of the license fee is a breach of

this License and a violation of international copyright laws. 

Subject to all of the terms of this License, you may, without making any payment to ExtraBit: 

a) give exact copies of the evaluation version of SpaceMan 99 personally to anyone;

b) distribute exact copies of the evaluation version of SpaceMan 99, if done exclusively through electronic

channels; and

c) make as many exact copies of this evaluation version of SpaceMan 99 as you wish, for purposes of

distribution as described in (a) and (b) above.

2.2. Licensed Copy

Each Licensed Copy of SpaceMan 99 may be used on a single workstation. 

Each Licensed Copy may be accessed through a network, provided that you have purchased rights to

use a Licensed Copy for each workstation that will access SpaceMan 99 through the network. For

instance, if 8 different workstations will access SpaceMan 99 on the network, you must purchase rights

to use 8 Licensed Copies of SpaceMan 99, regardless of whether the 8 workstations will access

SpaceMan 99 at different times, or concurrently. 

All rights of any kind in SpaceMan 99 which are not expressly granted in this License are entirely and

exclusively reserved to and by ExtraBit. SpaceMan 99 is protected by copyright laws and other

applicable laws and treaties. You may use, install and distribute SpaceMan 99 solely as expressly

provided in this License. You may not rent, lease, loan, sublicense, modify, translate, reverse engineer,

decompile, disassemble, or create derivative works based on, SpaceMan 99, nor permit anyone else to

do so. You may not make access to SpaceMan 99 available to others in connection with a service

bureau, application service provider, or similar business, nor permit anyone else to do so. 

3. Warranty Disclaimers and Liability Limitations

SPACEMAN 99, AND ANY AND ALL ACCOMPANYING SOFTWARE, FILES, DATA AND MATERIALS,

ARE DISTRIBUTED AND PROVIDED "AS IS" AND WITH NO WARRANTIES OF ANY KIND, WHETHER

EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY WARRANTY OF

MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. EXTRABIT DOES NOT

WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE OF, OR THE

RESULTS OF THE USE OF, SPACEMAN 99. EXTRABIT DOES NOT WARRANT THAT THE

OPERATION OF SPACEMAN 99 WILL BE UNINTERRUPTED OR ERROR-FREE. 

EXCEPT TO THE EXTENT EXPRESSLY PROHIBITED BY APPLICABLE STATUTES, EXTRABIT SHALL

NOT BE LIABLE FOR ANY DAMAGE OR FINANCIAL LOSS ARISING OUT OF THE USE OF, OR

INABILITY TO USE, SPACEMAN 99. ANY LIABILITY OF EXTRABIT WILL BE LIMITED EXCLUSIVELY

TO REFUND OF THE LICENSE FEE PAID TO EXTRABIT. EXCEPT TO THE EXTENT EXPRESSLY

PROHIBITED BY APPLICABLE STATUTES, IN NO EVENT SHALL EXTRABIT BE LIABLE FOR ANY
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INDIRECT, INCIDENTAL, CONSEQUENTIAL, SPECIAL, OR PUNITIVE DAMAGES WHATSOEVER

RELATING TO THE USE OF SPACEMAN 99, OR TO YOUR RELATIONSHIP WITH EXTRABIT,

(INCLUDING, WITHOUT LIMITATION, LOSS OF DATA OR INFORMATION, LOSS OF PROFIT,

REVENUE, BUSINESS OPPORTUNITY OR BUSINESS ADVANTAGE, OR BUSINESS

INTERRUPTION), WHETHER BASED UPON A CLAIM OR ACTION OF CONTRACT, WARRANTY,

NEGLIGENCE, STRICT LIABILITY, CONTRIBUTION, INDEMNITY, OR ANY OTHER LEGAL THEORY

OR CAUSE OF ACTION, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

IN ADDITION, IN NO EVENT DOES EXTRABIT AUTHORIZE YOU OR ANYONE ELSE TO USE

SPACEMAN 99 IN APPLICATIONS OR SYSTEMS WHERE SPACEMAN 99'S FAILURE TO PERFORM

CAN REASONABLY BE EXPECTED TO RESULT IN A SIGNIFICANT PHYSICAL INJURY, OR IN LOSS

OF PROPERTY, OR IN LOSS OF LIFE. ANY SUCH USE IS ENTIRELY AT YOUR OWN RISK, AND

YOU AGREE TO HOLD EXTRABIT HARMLESS FROM ANY AND ALL CLAIMS OR LOSSES

RELATING TO SUCH UNAUTHORIZED USE. 

4. General

This License is the complete statement of the agreement between the parties on the subject matter, and

merges and supersedes all other or prior understandings, purchase orders, agreements, and

arrangements. This License shall be governed by the laws of England. There are no third-party

beneficiaries of any promises, obligations, or representations made by ExtraBit herein. Any waiver by

ExtraBit of any violation of this License by you shall not constitute, nor contribute to, a waiver by

ExtraBit of any other or future violation by you of the same provision, or any other provision, of this

License. If any part of this License or the application thereof to any person or circumstance is for any

reason held invalid or unenforceable, it shall be deemed severable, and the validity of the remainder of

this License, or the applications of such provision to other persons or circumstances, shall not be

affected thereby. 

SpaceMan 99 Copyright © 1998-2014 by ExtraBit Software. All rights reserved.
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